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What is SugarPrint? 
SugarPrint is an AddOn for SugarCRM CE that enables printing to PDF / XLS export of any:  

• ListView  

• Detailview  

• CalendarView  

 

SugarPrint is also a simple and powerful reporting tool:  

1) Filter data with the search panel of SugarCRM  

2) Click on SugarPrint  

3) Indicate the calculations (sums medium counts) and clusters  

4) Create the report  

 

A few clicks without moving from List!  

 

SugarPrint is unique  

All other reporting tools require users to activate the form of reports, select the report, change 

the parameters to run the report  

 

SugarPrint harnesses the power of the search for SugarCRM: simple or advanced search are an 

important tool for users. Why not make it possible to extract results in an elegant PDF or an Excel 

file handy? 

 

Why SugarPrint? 
Our regular users of SugarCRM frequently ask us to print or export the information from various 

modules.  

They filters records on any modules and would then have the results printed in PDF or exported to 

Excel format.  

They want to make selections, groupings. calculations on that results 

It needs a reporting module? Not always.  

Quite often calculations are very simple and the data are in front of their eyes and do not want to 

repeat the same questions in a reporting module: they have no time to lose!  

We made SugarPrint to respond to these users. To your users! 

 

 

Features  
 

• Print PDF (1 click for printing all pages) of any SugarCRM ListView  

• Print PDF of detail and subpanels of any SugarCRM Detailview  

• Print Calendars PDF of SugarCRM  

• Crosstab reports NEW!!! 

• Create fles DHTML Grids with subtotals and nested group by  

• Ability to add extra modules fields are not present in ListView 
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• Sorting columns in the Report PDF  

• Group by with multiple subtotals and grand totals  

• Reports with calculations: sum, average, count  

• Export to Excel (not csv) of the records of the ListView  

• Export to Excel (not csv) of Detailview: details + subpanels (one for each sheet)  

• Security in the printing of records: print only records that the user can view  

• Compatible with SugarCRM ACLs and Security Suite  

• Pie charts, bar charts, histograms from each ListView 

• Save reports as public report or private report 

 

 

How to use SugarPrint 
 

Use SugarPrint is very simple.  

 

SugarPrint is automatically activated in your CRM for all modules and allows you to print to PDF, 

export to Excel and display a grid of information in the form.  

 

You do not have to build any report. SugarPrint works on SugarCRM filters and Listview results. 

Simply by activating the icon of SugarPrint you can print and process information as you wish.  

 

SugarPrint allows you to print and export:  

• all lists of SugarCRM  

• the dossier of each record (header and related subpanels)  

• calendars are SugarCRM (day, week, month and shared) 

 

Report types 
In the current version of SugarPrint provides the following types of reports:  

• Report: columnar report with the possibility of grouping totals and subtotals  

• CrossTab Report: crosstab with one SugarCRM field for columns and one for rows plus a 

summary fields to calculate 

• Report summary: there are two columns, one of which includes the values of the other 

sums which performs  

• Pie chart: pie chart drawn by two columns selected by the user  

• Histogram: Histogram drawn from two columns selected by the user  

 

 

Create reports form Listview 
 

SugarPrint SugarCRM works on any Listview  
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SugarPrint makes available in each Listview printing and reporting of records  

 

It only works on Listview SugarCRM, each custom module that uses the normal Listview 

SugarCRM.  

 

It does not work if the Listview has been replaced with a special Listview with different structure 

from the standard: a custom view with custom code. 

 

Quickly print records with a click  

 

Many times after performing a search on a module users need only to print in PDF format and 

then maybe on paper. Obviously they want to print all pages with a single click  

 

With SugarPrint can activate the Print icon to SugarPrint in Listview and with a click on PDF Report  

obtain a stylish and professional PDF printable file. 

 

How to create a report  

In addition to printing the records in a few seconds you can get a report in PDF format that makes 

calculations on the rows and columns of the Listview  

 

To create a report with SugarPrint:  

• Click on SugarPrint icon  

• Modify if necessary the report name  

• Go to the Design tab  

• If you desire, Drag the rows to get the order of the columns in the report: from top to 

bottom from left to right corresponds to the report  

• Select the flags on columns of interest and columns to group 

• Indicate which of the other columns to perform calculations  

• In the Format tab, specify the format of the PDF file   

• PDF report to run the report 

 

Save a report  

After you set up a report and before creating the PDF, you can go to Save tab, and click on Save 

report button. 

Please select the flag if the report will be "private": only for me option. 

 

NOTE: Normally report is used by all users but the data probally will be different for different 

users: SugarPrint guarantees maximum and full compliance with the rules and roles of  SugarCRM 

and Security Suite. 

 

The name of the saved report is taken from the title of the report. If the name already exists 

creates two reports with the same name.  
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To manage the list of saved reports and possibly to delete or rename reports  use the module 

SugarPrint. 

 

NOTE: it is not possible to add reports from SugarPrint module. This module is only to manage 

Reports.  

But the users that want to use SugarPrint need to access to SugarPrint module 

 

 

Extra fields: how to add columns to the report  

SugarPrint allows you to add the columns in the form of SugarCRM that do not appear in Listview 

in use.  

To add columns: 

• Click on Report icon on ListView 

• Goto Design tab 

• Use the button Get more fields  

The additional fields are displayed with a white background, those in Lsitview with gray 

background.  

You can perform the same processing on the additional fields that apply to the fields in the 

Lsitview only difference is that SugarPrint will require additional processing and reporting will 

need extra time to be prepared and submitted in PDF format. 

 If there are many records to be printed (eg, a few hundred) you might have expected significant. 

 

Run a saved report  

To run an existing report you have to use dropdown tab of the Report: 

• Click on Report icon on ListView 

• Use the dropdown  

 

Selecting a report loads all parameters of the selected report.  

At this point there are two possible options:  

• the user use the report with actual data in the listView: click on PDF Report  

• the user wants to load data from filters saved with the report before: use the button “Load 

data from report parameters” 

 

With the button " Load data from report parameters the Listview is reloaded with the new filters  

 

PDF file format 

SugarPrint allows you to specify the format of the PDF for each Report: a report with many 

columns requires a horizontal format with a size large.  

For a Report in which table columns are too narrow you have to expand the size of PDF file format. 

By choosing a custom format, the user can specify the width and height of the page. The 

measurements are in points.  

Information about the format are saved when the report is saved, and it can change from one 

report to another. 
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SugarPrint ListView dialog  
 

Report Tab 

 

 
 

 

Type 

When you select report type SugarPrint changes the contents of the Design tab to allow the 

construction of the report.  

 

Title 

The title of the report is printed on the header of the PDF Report.The title is also used as the 

report name when you save the report: if there is a report with the title indicated, two reports are 

saved with the same name. You can use SugarPrint module (as a standard SugarCRM module) to 

change title and delete reports, but not to create new reports: only with this dialog you can create 

and save reports.   

 

 

Run existing report 

You can load the saved reports for the current SugarCRM module  

Selecting a saved report is loaded with all the saved parameters.  

Also your search filters previously saved are loaded and with the button "load data from the 

report parameters" you can run query to filter with these filters 
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Design Tab for type Report 

 

 
 
Drag to sort report columns 

It is possible to drag any rows (report columns) to order the report columns: top to bottom means 

left to right columns 

 

Select Group Calc 

Select fields you want to show in your report, group by field (first group is topmost row with group 

by selected) and click to select Summary Average, Count on any numeric or currency field 

 

Get more fields 

With this option you can retrieve from your SugarCRM any other fields of the current module. 

Then you can select, group or calc on these fields.  
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Design Tab for type CrossTab 

 

 
 

Select field for columns 

The columns of the crosstab report will be by grouping the values of the selected column.  

Please do not to select a column with a large number of distinct values. The-max number of 

distinct values allowed is 30. 

 

Select field for rows  

Enter your desired field for distinct values of the row.  

There is no limit in the number of distinct values for the rows. 

 

Get more fields 

With this option you can retrieve from your SugarCRM any other fields of the current module. 

Then you can select, group or calc on these fields.  
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Design Tab for type Report Summary and Chart 

 

 
 

Select field to group 

For Report summary and for chart you have to select one field to group: only one series of data 

 

Select field to sum 

Select field to be summed 

 

Get more fields 

With this option you can retrieve from your SugarCRM any other fields of the current module. 

Then you can select, group or calc on these fields.  
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Format Tab 

 

 
 

 

PDF Format 

If you wnat a report with a lot of columns please enter a page format which may contain all the 

columns. If you select Custom format you have to input width and height unit of measure is Point. 

 

 

Date Interval 

It Indicates the time interval with which to group the dates in the report when a date field is used 

for a group or for a crosstab report or a graph.  

For example, if, in a crosstab report, you select a date range for the columns, and indicates the 

Month as the interval, the columns will report the months corresponding to the values of the 

selected field. 

 

 

Sorting the records in reports  
SugarPrint does not make any sort on records. The report follow the same sort of records present 

in Listview  

Therefore before using the report button SugarPrint verify the sorting of lists and change it with 

click on the column names. 

Export to Excel  
SugarPrint allows you to export to Excel any ListView and DetailView  
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Export from Listview  

Allows you to create and view an Excel file all the data of a Listview organized a single workbook.  

Follow the following steps:  

Activate Report icon on the ListView  

Select Export to Excel from the Report type in the dropdown  

Possibly change the parameters tab Design  

4. Click on Export to Excel  

 

Export from Detailview  

Activating the Report icon  in Detailview, SugarPrint creates an Excel file that contains a worksheet 

for the head and a sheet for each subpanel.  

In subpanels are displayed all rows (although on most pages) related to the record of the 

DetailView. 

 

 

 


